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Preamble 
For many years I participated in the teaching of Prof. Ann Palmenberg classes, in particular 
teaching about molecular graphics on the Desktop at a time when computer use in the 
classroom was not yet preeminent. This class was a useful complement to the main topic of 
Sequence Analysis and Evolution also using computers. 
 
I personally used what was called “Unix Workstations” (Silicon Graphics, sgi) which had 
powerful graphics and rather beautiful “photorealistic” renderings. For teaching molecular 
graphics on the Desktop, I first used Rasmol, which was an amazing software fitting in 
about half of a 3.5” floppy disk or about 500 kilobytes. Rasmol included a sophisticated line 
command language but lacked the beautiful “photorealistic” renderings of the workstations. 
This was remedied by adding two other software in the course, one for the “publication 
quality renderings” (VMD) and the other for the modeling abilities of side-chain mutations 
and automated 3D superimposition of structures (Swiss PDB viewer later called DeepView.) 
 
When PyMOL was still in preliminary development at version 0.99 I spent one intense week 
porting all the class material to PyMOL. Now, rather than using three different software, all 
was possible with only PyMOL. Over the years I extended and updated the PyMOL course 
material. 
 
The UW-Madison Biochemistry students were the primary audience for these classes in 
courses Biochem 660 and 712, and occasionally in Biochem 511. I offered the PyMOL class 
in Biochem 660 for over a decade. The PyMOL tutorial and preliminary molecular graphics 
and file format introduction were part of a very large, made-to-order physical copy of a class 
book of about 500 pages that also contained tutorials on using other software. The PyMOL 
section was about 200 pages. 
 
2017 was the last year that Biochem 660 was offered. I have therefore decided to release the 
complete PyMOL tutorial which you will find split in multiple PDF files. In this final 
revision, I had updated all web pages, and added links to archived pages when web site were 
defunct to keep the text as relevant as possible for future use. 
 
I hope that it will be useful to you in accomplishing your molecular graphics goals. 
 
Sincerely, 
 
Jean-Yves Sgro, Ph.D. 
Distinguished Scientist | Senior Scientist 
Biotechnology Center      | Biochemistry Department 
University of Wisconsin-Madison - USA 
Email: jsgro@wisc.edu 
Formerly at the Institute for Molecular Virology and VirusWorld web site creator. 
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PyMOL  (3) – Electron 
Density Map – (Optional) 
✔✔ READ:  Electron density is the measure of the probability of an electron be-
ing present at a specific location.  In protein crystallography, an electron density 
map averaging all the molecules within the crystal allows a crystallographer to 
build a model of the molecule.   
 

Workflow for solving the structure of a 
molecule by X-ray crystallography. 
(source: wikipedia) 

 
 
Calculation of the electron density map1: The data col-
lected from a diffraction experiment is a reciprocal space 
representation of the crystal lattice. The position of each 
diffraction 'spot' is governed by the size and shape of the 
unit cell, and the inherent symmetry within the crystal.  
 
The intensity of each diffraction 'spot' is recorded, and 
this intensity is proportional to the square of the struc-
ture factor amplitude. The structure factor is a complex 
number containing information relating to both the am-
plitude and phase of a wave and is a mathematical de-
scription of how a material scatters incident radiation.  
 
In order to obtain an interpretable electron density map, 
both amplitude and phase must be known (an electron 
density map allows a crystallographer to build a starting 
model of the molecule). The phase cannot be directly rec-
orded during a diffraction experiment: this is known as 

                                                
1 http://en.wikipedia.org/wiki/X-ray_crystallography 
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the phase problem.  
 
Initial phase estimates can be obtained in a variety of ways including molecular 
replacement and heavy atom derivatives. 
 
The final atomic model is deposited after a series of refinements. Some authors 
choose to deposit the electron density map or a structure factor file that can be 
used to calculate an adequate electron density map. 
 
For further information:  
 
http://pymolwiki.org/index.php/Display_CCP4_Maps 
 
The Protein Data Bank is the primary source of atomic models. However it now 
links to the Electron Density Server (EDS)2 when a map is available.  
 
“The Uppsala Electron Density Server (EDS; http://eds.bmc.uu.se/) is a web-
based facility that provides access to electron-density maps and statistics concerning the fit 
of crystal structures and their maps.” 

11.. DDoowwnnllooaadd  aann  eelleeccttrroonn  ddeennssiittyy  mmaapp  
 
We will use the now familiar 2BIW entry, biological unit 2 that was the basis of 
multiple exercises in previous sections. The file 2biw.pdb2 should be on your 
desktop or you can download it again from the web browser link below. Alterna-
tively you can use the fetch command as before to load that single protein chain. 
 
The electron density map can be obtained directly from the EDS server or via a 
link to the EDS server from the PDB page. In both cases the user will land on the 
page on the EDS server. 

11..11 GGoo  ttoo  EElleeccttrroonn  DDeennssiittyy  SSeerrvveerr  ppaaggee  
 
 • Open a web browser such as Safari or Firefox. 

• Point your web browser to www.rcsb.org 

                                                
2 The Uppsala Electron-Density Server. G. J. Kleywegt, M. R. Harris, J. Zou, T. C. Taylor, A. 
Wählby and T. A. Jones. Acta Cryst. (2004). D60, 2240-2249  doi:10.1107/S0907444904013253 
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✔✔ TASK 
• In the Search box type the following ID: 2biw  
• Then click Search button 

 
 
If the PDB entry has 
an EDS file, the rele-
vant link will be pro-
vided within the “Ex-
perimental Details” 
panel on the bottom 
right of the entry page. 
 
 

 
 

✔✔ TASK 
At the bottom right of the entry page click on the EDS link (shown by arrow.) 
This will open a new page displaying the information from that entry directly. 
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✔✔ INFO 
 
Alternate method: go to the EDS 
server (http://eds.bmc.uu.se/eds/) 
and enter 2biw in the PDB code box 
and click submit. 
 
Regardless or the method, the end 
page will be the same. 
 

 
 

  
✔✔ INFO 
 
The EDS summary page lists most 
parameters related to crystallog-
raphy. 
 
The bottom part of the page echoes 
the header portion of the actual PDB 
data file. 
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11..22 DDoowwnnllooaadd  eelleeccttrroonn  ddeennssiittyy  mmaapp  iinn  CCCCPP44  ffoorrmmaatt  
 
Just like everything else for computer files, there are various formats available. 
CCP43 is a format PyMOL understands. 
 

✔✔ TASK 
• On the left panel under Download, Click on Maps 

 
 

• Select CCP4 as 
the map format 

• Keep Type the 
same  

 
• Press “Gener-

ate map” but-
ton 

 

 
 Electron-density map generation for 2biw 

Generating map.... 
This may take a few seconds, or many minutes, depending on the size of your 

map. 
    Here is your gzipped map:2biw.ccp4.gz            .     
 

     
• Download the proposed file 
• Rename the uncompressed file: 2biw.map.ccp4 

 
Alternate method: use the fetch command to download an electron density map 
called 2fofc (for 2-sigma observed / calculated in the crystallographers’ jargon) but 
note that the download of the map does require some time before it is updated 
within PyMOL.  
See the following example 
 
  fetch 2biw, type=pdb2 
  fetch 2biw, type=2fofc 
  isomesh 2biw_map, 2biw_2fofc, 1.06, poly, carve=2.5 
 
 

                                                
3 The Collaborative Computational Project Number 4 in protein crystallography or (CCP4) was set 
up in 1979 in the United Kingdom to support collaboration between researchers working in soft-
ware development & assemble a comprehensive collection of software for structural biology. 1979. 
http://en.wikipedia.org/wiki/Collaborative_Computational_Project_Number_4 
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Alternate method 2: The new menu File > 
GetPDB can now be used to automatical-
ly download both the PDB and the map: 
simply click the 2FoFc Map button. 
 
Reminder: we are here calling for the 2nd 
biological monomer (Assembly) here set 
to 2 and it is also necessary to specify the 
chain ID (here B which matches the 2nd 
monomer.) 

 
 
 
 
 

 

22.. DDiissppllaayy  eelleeccttrroonn  ddeennssiittyy  mmaapp  
 
(Assumes you completed previous exercise and downloaded map) 
 

Note: the newest version of PyMOL will embed the map from the above 
command. Simply follow the “mesh” command below to visualize. Howev-
er, for the command to work change the word 2biw.map to the name given 
automatically: 2biw_2fofc 

22..11 OOppeenn  PPyyMMOOLL  aanndd  MMaapp  
 

✔✔ TASK 

If the file has a PyMOL icon, simply 
double-click the icon to open a new 
PyMOL session. Or simply launch 
PyMOL and use the File > Open 
menu.  

 
The top section of PyMOL will echo information about the opened file: 
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 ObjectMapCCP4: Map Size 160 x 145 x 155 
 ObjectMapCCP4: Normalizing with mean = -0.008028 and stdev = 0.211077. 
 ObjectMap: Map read.  Range: -2.930 to 8.486 
 Crystal: Unit Cell          119.050  125.275  203.087 
 Crystal: Alpha Beta Gamma    90.000   90.000   90.000 
 Crystal: RealToFrac Matrix 
 Crystal:    0.0084   -0.0000   -0.0000 
 Crystal:    0.0000    0.0080   -0.0000 
 Crystal:    0.0000    0.0000    0.0049 
 Crystal: FracToReal Matrix 
 Crystal:  119.0500    0.0000    0.0000 
 Crystal:    0.0000  125.2750    0.0000 
 Crystal:    0.0000    0.0000  203.0875 
 Crystal: Unit Cell Volume  3028845. 
 ExecutiveLoad: "/Users/dmc/Desktop/2biw.map.ccp4" loaded as "2biw.map", through state 1.  

 

  
Do not panic if your screen still appears black at this point!  
This is normal. 

 
 
In the Names panel click on 2biw.map to let the 
volume of the map appear as an empty cube. 
 
Then: 
Click on Action (A) and select mesh @ level 3.0 
to show the corresponding electron density. 
  
This will create a new entry in the Names Panel called 2biw.map.mesh 
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The electron density map for the complete section of space is presented at the level 
3.0. Of course that is too much information and we will reduce the section of the 
map that is shown and play with the density level as well. 
 
Note: we selected the “mesh” option within the Action menu. There is also a “sur-
face” option that could be useful in some cases, perhaps with added transparency. 

22..22 CChhaannggee  eelleeccttrroonn  ddeennssiittyy  lleevveellss  
 
Typically, contour level values are reported in the absolute value of electrons/Å3. 
 

✔✔ TASK 

Click Action button for name 
2biw.map.mesh and select level 2.0 
 
This will change the displayed density in the 
viewer.   

 
You can check the effect for other values, and then come back to a value of 2.0 

33.. AAdddd  PPDDBB  aanndd  rreedduuccee  ddiissppllaayyeedd  aarreeaa    
 
The electron density map should be displayed at level 2.0 from the previous sec-
tion. 
 

✔✔ TASK 
Load the PDB data within PyMOL with the line commands: 
 
    fetch 2biw, type=pdb2  

 
When the PDB file is loaded, PyMOL automatically zooms on the location of the 
atom coordinates. The familiar bonds between atoms are masked by the electron 
density map. The many other sections of the electron density map representing 
crystallographic symmetry can be later removed for clarity. 

33..11 DDiissppllaayy  eelleeccttrroonn  ddeennssiittyy  ffoorr  tthhee  ccoommpplleettee  pprrootteeiinn  
 
The following commands select which region of the map to display (variable name 
site chosen for the complete protein) and the next command creates a new map 
around the selected site: 
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✔✔ TASK 
    select site, 2biw 
    isomesh map, 2biw.map, 2.0, site, carve=1.6 

 
This will create a local map under the name “map” within the Names Panel. 
 
In the Names Panel click on 2biw.map.mesh to hide the general mesh map. 
This will reveal the local map around the single protein. 

33..22 IIlllluussttrraattee  eelleeccttrroonn  ddeennssiittyy  rreessoolluuttiioonn  vviiaa  mmaapp  lleevveellss  
 

✔✔ TASK 
Rotate the structure to better see Tryptophane 121 
To help you can use line command: orient resi 121 
that can also be written as: orient i. 121 

 
Change map level to 1.5, 1.0 and then to 0.5 (map > A > level > 1.0) to illustrate 
the increase of electron density map drawn at this location. It is due to the lower 
resolution of the map at this site: most W121 atoms would have a higher tempera-
ture factor within the PDB file. 
 

    
level 2.0 level 1.5 level 1.0 level 0.5 

 
Note that ASP 331 at the bottom of the page follows the same pattern of electron 
density map plots as the levels vary. 

44.. DDiissppllaayy  aa  llooccaall  aarreeaa  oonnllyy  
 
Starting point: previous exercise showing map at level 0.5. 
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We will select a local segment which is in alpha-helix configuration and display 
the electron density of this local area. 
 

✔✔ 
TASK 

 select local, resi 95-105 
 isomesh local_map, 2biw.map, 1.0, local, carve=1.6 

 
Note: the words “local” and “local_map” are created by the user and are not 
PyMOL commands reserved words. 
 
On the Names Panel Click 
on “map” to remove it 
from view.  
 
Only the wireframe of the 
protein should remain and 
the local electron density 
plot we just created. 

 

✔✔ TASK - With the mouse do the following: 
 
- Hide the protein wireframe:    2biw.pdb2 > H > everything 
- Show the local helix in wireframe:  local > S > sticks    
- Zoom on the local area with the mouse. 
 
Using line commands: 
 
center local  # change center of rotation to local area  
color gray50, local_map # set color to 50% gray  
bg_color white   # change background to white 
set mesh_width, 0.5    # makes meshes thinner, for raytrace 
 
The following are optional settings: remove # to activate. 
 
# set ray_trace_fog, 0 # turn off raytrace fog;  
# set depth_cue, 0     # turn off depth cueing 
# set ray_shadows, off # turn off ray-tracing shadows 
 
Press the “ray” button or type ray within the line-command are to finish. 
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Ray-traced image from above settings with additional cartoon & thicker mesh width (1.0) 

 
Another example for 2 amino acids clise up: 
 

 
 

On the display Ray traced with default parameters 

 

 
gh 
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;;11 Optional Tutorials  
These tutorials are no longer printed in the standard book but are available as PDF 
downloads taken from previous book versions but are no longer updated. 

 

11 RRaassmmooll  
 

Various versions of Rasmol exist. The 
tutorial is for the X11 version. All 
commands runs the same in all ver-
sions, only the launching is different. 

22 VVMMDD  
 

VMD requires UNIX end-of-line. 
Useful option to create lipid bilayer 
and ambient occlusion depth-cueing 
options. 
(see next page!) 

33 DDeeeeppVViieeww    
(Formerly Swiss PDB 
Viewer)  

 Specially useful for side-chain muta-
tions and for 3D structure superim-
positions. But now this is done with 
PyMOL. 

44 QQuuiicckkTTiimmee  

PPrroo   

QuickTime is useful to assemble im-
ages into movies or re-export existing 
movies. Not necessary when using  
MacPyMOL. 

 
Where to download:  http://virology.wisc.edu/acp 

 
Click on “Class Tutorials” 
 
Then under “Our Tutorials” use the pull-down menu to select the PDF you want 
to download. It will open automatically in your browser. To save simply use the 
“Save As” command from the “File” menu in the browser. 

gh 
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VMD: Ambient Occlusion 

 
 

VMD OpenGL Dispaly TGA rendered file with Ambient Occlusion 
 
VMD: Membrane Builder (VMD Main: Extensions > Modelling > Membrane Builder) 
 

 



Molecular Graphics with: PyMOL 17 

 

MyMolecule 17 

 

“My Molecule” – Student 
Molecular Graphcics Presentations 

11.. HHOOMMEEWWOORRKK  EEXXEERRCCIISSEE  ((iinn--ccllaassss  

pprreesseennttaattiioonn))  
 
My Molecule Homework Project: to be presented by teams in laboratory.  
 
Now that you (will shortly) know all there is to know about structure display from 
your exercises with PyMOL & other optional tutorials, and you also know a bit 
about presentations and movies in PowerPoint, it’s time to assimilate these skills 
and use them to illustrate some real research points. 

11..11 WWhhaatt  yyoouu  hhaavvee  ttoo  ddoo::  
 
1.  Pick a project partner.  The class will be divided into groups of 2 or 3 students 
each.  Partner selections will be finalized during the second Graphics lab (L02) 
segment.  
 
2. You and your partner(s) should go online to the pdb database 
(http://www.rcsb.org/pdb/) and pick one (or more) crystal structure files (or an 
NMR structure set) that is of interest to you. It could perhaps be an enzyme related 
to your own research, a protease, an RNA (e.g. tRNA), a protein /nucleic acid 
complex, a set of amino acids, bases or whatever... just so long as there is a pdb file 
encoding it (or them).  
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3. Read a few of the research papers associated with this (these) structures. Re-
member, pdb files have references listed at the top of each file within the header 
just so you can learn the salient features of the molecule and why people consider 
it biologically interesting. You DON’T need to go into great depth here, the idea is 
to gather some interesting information about mechanisms, active sites, substrates 
etc., so you will have some concepts to illustrate. 
 
4. Using PyMOL, VMD, Rasmol, DeepView or any other molecular display pro-
grams available to you (or even other stuff you might find on the web), create some 
nice images of your molecule(s) that illustrate key features of its molecular biology. 
For example, if you were working with HIV protease, you might be interested in 
highlighting the active site residues or the substrate binding pocket, among other 
features. On a tRNA, the anticodon loop or the bases that make contact with the 
synthetase might be of interest. In an NMR structure, the differences among the 
various structures might be of interest (where do they wiggle?) etc. Get creative 
with several different views, using surfaces or electrostatic potential, or whatever, 
to highlight and illustrate any interesting points. You might wish to compare or 
contrast elements from related structures. (Where is the HIV protease different 
from the SIV protease, for example, and why might these differences be related to 
their activities?) Or perhaps you may wish to show how a substrate/inhibitor 
binds in an active site. Use your imagination! Use humor! No holds barred! 
 
5. Capture your images as graphics files (PNG, GIF etc.), import them into Power-
Point, and create a short presentation (8-10 slides) telling a story about your mole-
cule. Add text, builds, short movies (if you make them), references or any of the 
other features of PowerPoint to your file that you think might be helpful and at-
tractive.  
 
6. During the laboratory on the week of these presentation (L06), you and your 
partner(s) should bring to lab, a (PC or Mac formatted) CD disc or a USB 
thumb/flash drive containing your “My Molecule” presentation**. Be sure to in-
clude on this disc: any QuickTime (MOV, MPEG or AVI) movies that are refer-
enced by your file or they won’t play when you think they would. Each partner in 
the group should plan to participate in a 10 minutes (total/group) oral presenta-
tion with another 5 min for questions about graphic methods or topic content.  
 
Instructors will provide a Macintosh computer (Windows MIGHT be an option 
too) with CD drive and USB port, hooked up to an XGA-level projector.  These 
presentations will be graded (for all students in the group by all students in the 
class), on the basis of originality, clarity, and creative use of program tools to illus-
trate some salient aspect of protein/nucleic acid biochemistry. The idea here is to 
demonstrate that you can use the molecular graphics tools available to you, to de-
velop illustrations or animations that are clear and informative to an audience.  
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7. BOTH/ALL partners in each group must participate equally in the planning, 
execution and presentation phases of this project. Each will be assigned the same 
grade for the exercise according to feedback sheets filled out by your classmates 
and instructors (your audience) after each presentation.   
 
8. We are not so much concerned with presentation content (which molecule you 
choose, or what you learned about it), but rather, how you choose to illustrate your 
points with the creative and clear use of graphics techniques. Have fun with this 
learning opportunity and your audience will have fun too! 
 
** The instructor’s Macintosh in the DMC is equipped with a CD/DVD reader and 
has a USB port for flash drives. It also runs QuickTime and the latest version of 
PowerPoint. HOWEVER, to ensure that YOUR file made on YOUR computer (or 
your lab’s computer) runs smoothly on this machine, it is a good idea to adhere to 
these simple formatting caveats: 
 
a. When creating your presentation in PPT, make sure in EDIT > PAGE SETUP you 
have configured your file for OnScreenShow or it may have funny dimensions when 
you go to display it.  
 
b. It is a good idea to keep the size of your PPT file under 30 Mb (you may need to 
trim your picture file resolution if they are too big). Be forewarned that files bigger 
than this, or even movies bigger than 7-8 Mb may have trouble playing on another 
machine. Be careful, because you don't want to spend your 10 min presentation, 
fixing your file. Test it ahead of time e.g. the week before.  
 
c. If you want to test a practice file or figures for preview, please be sure to bring a 
test disc to the lab before MyMolecule day. You will not have access to the DMC 
lab outside of regular class hours.  
 
d. If you use a PC to create your presentation, do NOT use keyboard shortcuts to 
insert symbols, Greek letters or bullets. Only fonts selected from the standard PPT 
font list, and which are also common to the DMC Macintosh will display without 
error. 
For safety, stick to simple fonts like: Arial, Times, Syµbol (Symbol,) 
Courier, Helvetica, etc.  
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11..22 WWhheerree  ccaann  yyoouu  wwoorrkk  ttooggeetthheerr  wwiitthh  yyoouurr  ppaarrttnneerr??  
 
You can make use of the 3 iMacs terminals in Biochem 301 Biochemistry Laborato-
ries Addition (see page 5 of the book for details.) They are programmed with all 
course-supported software that function in Macintosh OSX: DeepView, RasMol, 
VMD, PyMOL, Chimera, QTpro etc. are all installed. Non-Biochem student will be 
given a personal username:password that will allow them to logon to these termi-
nals and save their work on Biochem server space. Biochem students use their ex-
isting account. Biochem 660 students should already have a username. 
 
Or, you can work at home from your own personal computers. To store your files 
between sessions, or while you are working with your partner you can use the 
Enterprise Box Service offered by UW-Madison to all students, faculty and staff 
uwmadison.box.com 
 

– END – 
Class notes 
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